
Welcome to the devious and labyrinthine King's Casino context sensitive help system. Click on any 
grey square button below to move to the topic labelled beside it. Once there or anywhere else in 
Help, the Back button above will move you back one screen, while the Contents button will always 
bring you back here.

 Getting Started
 Rules and Instructions for Each Game
 Using the File and Game Menu Choices
 Using the Actions Menu Choices
 Using the Options Menu Choices
 Scoring and Gambling
 Registering, Upgrading, Reaching the Author
 Adding to the Artwork
 Program Notes and Credits
 Glossary of Terms
 License Agreement



Getting Started
Solitaire (or patience) is not one game but a family of games which have in common that there is 
only one player. The currently popular solitaire game which is packaged with Windows is actually 
named Klondike. Solitaire involves piles of cards arranged in the unique layout of each game. Most 
solitaires are won when all cards are moved according to certain rules from other piles to the 
destination pile or piles - usually the foundations.

 History of Solitaire Card Games
 You're Not In Klondike Anymore
 Menu Basics
 Game Layouts and Card Piles
 Game Play



History of Solitaires
Solitaire card games may have been around as long as playing cards (since about 1400 AD). There 
is little record of single player games until it was recorded that Napoleon whiled away his time in exile
on the island of Melba with a two deck solitaire game. Because of the off-handed nature of the 
reference, it seems probable that solitaires were common knowledge at that time. During the period 
of the French Revolution the tradition began in democratic countries of ranking the Ace above the 
King. (Needless to say, the King is always high in King's Casino Solitaire.)

During the nineteenth century, a sort of Hoyle's book of solitaire games was published in England, 
vastly adding to the popularity of this family of games. Meanwhile in the U.S. during the goldrush era,
a fellow named Canfield became rich from the Canfield Casino in which customers bought a deck of 
cards for $50, played Canfield solitaire, and won back $5 for each card one played to Foundation 
piles under the watchful eye of a Canfield croupier.

In North America, at least, during the twentieth century, a distant cousin to the Canfield game, 
technically named Klondike, became synonymous to many with the term solitaire. And, of course, 
history will record that in the final decades of the twentieth century, a temporary fluke in computer 
operating system marketing brought solitaires into renewed prominence.

Yet computer solitaire antecedes Windows, going back at least to Brian Irvine, who's 1986 Las Vegas
Solitaire is still one of the best. The idea of a suite of solitaire computer games to the best of my 
knowledge goes back to the commercial product Solitaire Royale by Fregger and Sandige. Then, of 
course, Wes Cherry's Windows Solitaire with its draggable cards blew us all away.



You're Not In Klondike Anymore

So you've played 1,342 games of Windows Solitaire (aka Klondike) but nothing else. So what's 
different between WinSol and all these new games and what stays the same?

 Similarities to Klondike
 Differences from Klondike

Are you courageous enough to chop your way through this uncharted wilderness? Bored enough with one
game to try others? Then let me introduce you to your native guides:

 Won't you Please, Please Help Me?



Similarities to Klondike
The following are the major similarities between the various solitaire games and that old stand-by, 
Klondike:

· Play cards to foundations to win. In all most all cases there are one or more piles (usually but not
always) across the top called foundations. In all the games in this suite except Scorpion your 
mission is to move all the cards in the deck to foundations.

· Build up on foundations; down on the tableau. This mostly holds true, but there are quite a few 
exceptions, as well.

· Click on the deck to deal the next hand of cards. The deck is always on the right here in the 
King's Casino and often has more cards than any other pile at the start of the game.



Differences from Klondike
The following are the major differences between the various solitaire games and Klondike:

· Reserves. Klondike has a deck, a waste pile, four foundations piles, and seven tableau piles. 
Many games, including Canfield, Dutchess, and Chameleon, have one or more piles called 
reserves. Cards are dealt to any reserve piles before play begins, then are available off the top of
each reserve pile like secondary decks.

· Familiar pile types may be missing. In the vast exotic rainforest of solitaire games there is no one
pile type which you can count on being present in every game. Some have multiple wastes but 
no tableau, others multiple reserves but no tableau or wastes. Scorpion has no foundations; 
King's Clover no deck, etc.

· Different build rules. As a Klondike player you are used to building down in alternating colours on
the seven tableau piles. You're used to building up in both rank and suit from Ace to King on the 
foundations. You're used to being only able to fill an empty tableau pile with a King. And so on. 
Variety is the spice of solitaire.

· Circular rank. As a Klondike pile you're used to foundation piles starting with an Ace and building 
up to a King. You're used to tableau piles starting with a King and building down to a Deuce. Ah, 
but you're not in Kansas anymore, Toto!



Won't you Please, Please Help Me?
Here are five friendly native guides to help you learn how to play all the different games in King's 
Casino Land:

· This help system. The Rules and Instructions for each Game topic off the opening Contents page
of this help system provides a helping hand for each game. There are screen shots and 
examples of play in each one. Simply press F1 when you have a game started on screen to go 
directly to the help topic for that game.

· Pile Info. If you have a game started on screen, right-click on any card pile. This pops up the Pile
Info dialog box, which is a complete instruction system on its own.

· Trial and Error. Dig in and start playing. As you try moving cards from one pile to another you'll 
initially be frustrated by things that do happen that you don't expect or that don't happen that you 
do expect. Just pop up Pile Info when you get confused and you'll soon be an old pro.

· Playing cards. Probably the fastest way to become conversant with a new game is to dust off an 
old-fashioned pack of playing cards. Pop up the F1 help for the new game, then shuffle and deal 
the playing cards in the layout shown. Just doing that much manually is half the battle. Now 
puzzle out what goes where from help for a few minutes and you're off to the races.

· Moorehead/Mott-Smith. If you really want to get into Solitaires, pick up The Complete Book of 
Solitaire and Patience Games. It's paperback, only a few dollars, illustrated, and includes 225 
different solitaires. The authors discuss tactics as well as what-goes-where. If King's Casino 
were a $50 commercial shrink-wrapped package, I'd include a copy in each box.



Menu Basics

The program menu starts with File menu which provides game selection shortcuts, allows you to 
save and open games, and to exit the program. The Games menu is next from which you select a 
game to play. The Actions menu appears once you start a game and contains Deal, Undo, and other 
play features. The Options menu allows you to customize the program. Finally, there's Help which is 
how you got here.



Layouts and Card Piles

(The Dutchess layout shown above has every pile type.)

If you've played with King's Casino a bit and started a few different games, you've seen that there's 
quite a variety of card positioning from game to game. In some games, when you start, cards are 
already layed out in some pattern, in others the grey pile markers are uncovered and indicate where 
future cards may go. The combination of all this is called the game's layout. King's Casino has two 
pile marker styles, which you can select from the Behaviours dialog on the Options menu. The 
outline style is useful when learning new games because it uses different shapes for different pile 
types:

Here is a list of the different classes of card piles and their indentifying markings:

· Foundations: TO piles marked by a solid gray rectangular card shape with a green circle or 
upward pointing wedge outline.

· Tableau: TO and FROM piles marked with a plain solid gray rectangular card shape or a 
downward pointing wedge outline.

· Waste: TO and FROM piles marked with a plain solid gray rectangular card shape or a simple 
rectangular outline.

· Reserves: FROM piles marked by a solid gray rectangular card shape with a red X or a simple 
rectangular outline. (The reserves in Eight Off and Tournament allow limited TO play as well.)

· Deck: FROM piles marked by a solid gray rectangular card shape with either a red X or a green 
circle depending on whether a redeal is allowed or by a rectangular outline with either a red or 
green circle.



Game Play
The subject of game play covers all the interactions between you the player and the cards on the 
screen for the current game.

 Winning
 The Initial Shuffle and Deal
 Dealing During Play
 Card Moves
 Pile Build Rules (adding cards to piles)
 Tactical Play
 Redeals



Winning
Ultimately, the goal of a game is to win. In all solitaires you win by moving all cards from the deck to 
one or more destination piles. In all games so far in this suite except Scorpion the destination piles 
are the foundations.



Initial Shuffles and Deals
When you select the game you want to play, the deck is automatically shuffled. Incidentally, the 
random number which starts the shuffle process is seeded by the exact time of your click - so wait for
those good vibes before starting each game, if you like to play your hunches! Next the initial layout of
cards (if any) is dealt from the deck to the appropriate other piles.

Undealt cards at the beginning of a game (if any) are in a single, fanned pile on the right called the 
deck.



Dealing During Play
When you've made all the possible and/or desirable moves with the currently available cards, in most
games you need to deal another card or cards from the deck. Depending on the game the deck will 
be turned face up or face down. 

· The top card on a face up deck is directly available for play at all times. Drag the top card to any 
other pile the build rules allow.

If the deck is face down there are several variations in how the player may deal (click on the deck or 
press the space bar to initiate a deal).

· a single card may be dealt face up to the waste pile or piles
· a batch of three cards may be dealt to the waste pile or piles
· or a single card may be dealt upon each of the tableau piles to the left of the deck.

(Long-time card enthusiasts occasionally question how King's Casino handles dealing batches of 
three. In many programs, if the number of cards in the deck happens to be evenly divisible by three 
(say fifteen), clicking on the deck multiple times will eventually cycle you back to the same first three 
cards, which will turn up again in the same order. In King's Casino the same process will return you 
to the same three cards but in reverse order! This often allows you to go farther in a game which 
would otherwise be deadlocked.

Try this with a deck of cards. Take any nine cards (to make it easy) and presume that's all that's left 
to play. Turn up the first three cards, notice which card is on top and which on the bottom of the 
three, then lay them down on the table FACE DOWN. Turn up the next three cards then lay them on 
the first three, also face down. Repeat with the final three. Now pick up the discard pile, turn it face 
up, and pick up the first three cards. Voila! - They're in mirror order. Just one of the many little ways 
in which we here in the King's own Casino try to make your life more enjoyable.)



Card Moves
Once the deck has been shuffled and any initial automatic dealing to the layout is complete, anything
that happens next is up to you. Your mission is to transfer all cards to foundations according to the 
rules of the game.

Single Card Moves
Any single card which is not buried even partially by one or more other cards is available for play 
when the rules of the game permit. You cannot move move cards TO reserve piles (in most games) 
or TO the deck. You cannot move cards FROM foundations. You cannot move cards FROM waste 
pile TO waste pile. Otherwise you move cards from pile to pile as long as the card is permitted by the
build rules of the destination pile. 

Multiple Card Moves
In many games, when a pile contains more than one card, you may move all or some of those cards 
as a block to another pile. For example, in Canfield you may transfer all the cards in one tableau pile 
to another tableau pile as a unit, providing the bottom card in the from pile fits on the top card of the 
destination pile according to build rules of that pile.



Pile Build Rules
Some piles have no restrictions on which cards may be added to them. Waste piles usually are of 
this type. Foundation and tableau piles, however, generally have one of the following types of 
restrictions:

· Same suit or same rank. For example, a pile may be restricted so that only Queens may be put 
on it. Another pile may allow any card of the Clubs suit, regardless of rank.

· Ascending or descending order by rank. For example, if the pile requires descending order by 
rank then a Ten of any suit may be played on a Jack of any suit or any Six on any Seven, but no 
Six may be played directly on a Jack (or on anything but a Seven).

· Ascending or descending order by both rank AND suit. For example, if the pile requires 
ascending order by suit and rank, then on the Jack of Hearts you may play a Queen of Hearts, 
but not the Queen of Spades or the Nine of Hearts. Ascending order by rank and suit is the most 
common requirement for foundation piles.

· Descending order by alternating colours (I haven't come across ascending alternating order). 
This means that a card of either black suit may be played upon a card of either red suit so long 
as the card is one less in rank. For example, a Seven of Diamonds may be played upon an Eight
of Clubs.

· To complicate all this is the concept (which does not occur in Klondike) of circular rank, which 
permits an Ace to be played on a King or vice versa.

During any game you can right-click on any pile to pop up the Pile Info dialog box showing the build 
rules and other information for that pile.



Tactical Play

In most solitaires the several tableau piles are the work space of the game. In others there are 
multiple waste piles and no tableau. The difference between tableau and waste is that you cannot 
move cards from one waste pile to another as you can among tableau piles. 

The ultimate driving force of all this moving about on tableau and waste is to get cards in the 
necessary order to transfer them to foundations. Foundation piles generally need to be built in some 
particular order, such as ascending by rank and suit, yet cards rarely favour us by coming off the 
deck in just that order. The only hope of a win is to rearrange the cards somewhere between the 
deck and the foundations. 

Thus we may transfer cards from one tableau pile to another or place them on one waste pile rather 
than another in the hopes of eventually organizing all cards so that they can be transfered to 
foundations.

In Klondike and Scorpion during the initial automatic deal certain cards are dealt to the tableau face 
down while others are face up. According to the rules of these games, whenever a face down pile 
becomes the top card on its pile it is turned face up and is thence forth available for play. In these 
games, exposing these face down cards is another one of the driving forces of play.

In all games with reserve piles, for example Canfield, Chameleon, and Osmosis, a strong driving 
force is to move all cards out of the reserve pile(s) and onto the tableau where they can be staged for
play to foundations.



Redeals
Once all cards have been played from the deck, in some games play stops, in others cards from the 
waste pile or even the tableau are gathered together and recycled to the deck. Depending on the 
game's rules one, two, three, or unlimited redeals are allowed.



Rules and Instructions for Each Game
Click on any game titled below for comprehensive instructions. All games are one deck (52 cards) 
games unless otherwise noted.

 Baroness
 Bristol
 Calculation
 Canfield
 Chameleon
 Dutchess
 Eight Off
 Four Seasons
 Golf
 Idiot's Delight
 King's Clover
 Klondike
 Little Spider
 Osmosis
 Penguin
 Perpetual Motion
 Pyramid
 Queen's Quadrille
 Scorpion
 Strategy
 Tournament
 Try Again
 Double or Naught



Baroness    (aka Thirteen, Five Piles)
· Brain drain: Low Odds:40 to 1

· Layout: five tableau piles on the left - a row of three above a row of two. One foundation pile 
upper right; deck, lower right. In the middle are two more tableau piles reserved for the end of the
game.

· To win: play all cards in any order to the single foundation pile to win.

· Tableau: Aces count as 1, Jacks 11, Queens 12, Kings 13, other cards their rank. Drag either of 
two uncovered tableau cards which add up to 13 on to the other to send them both to the single 
foundation. For example, in the game shown above drag the Four onto the Nine and the Jack 
onto the Deuce (then click on the deck for a new deal of cards to the tableau - the Five is not yet 
playable). Drag Kings alone onto the foundation pile. Unfortunately, you may not fill an empty 
tableau pile with a card from another pile or move cards between tableau piles.

At the end of the game the last two card of the deck are played to the middle two piles and may 
be used against the top cards on the other tableau piles.

· To Deal: When no moves remain, click on the deck to deal another round of cards to the tableau.
No redeal is allowed.



Bristol
· Brain drain: Medium Odds: 2 to 1

· Layout: eight tableau piles in a row with four foundations above them to the left, three reserves 
above them and to the right of the foundations. Finally, the deck is in the upper right corner.

· To Win: Play all cards to foundations in order by rank from Ace to King but without regard for suit.

· Deal: click on the deck to deal three cards at a time, one to each reserve pile.

· Reserves: Play cards one at a time to foundations or tableau.

· Tableau: build down regardless of suit. Move one card at a time from tableau to tableau or 
foundations. Empty tableau piles may not be filled.

For example, in the game shown above play the Ace of Spades from the last tableau to any 
foundation pile. Then play either Deuce from reserves upon the Ace. One might then play the 
Trey of Diamonds and Four of Hearts from the tableau to foundations, then move the Queen of 
Hearts upon the King of Diamonds to free the Five of Hearts. This might also be played to 
foundations to allow the Six of Diamonds on reserves to be played to foundations so not to bury 
it by the next deal.

· Note: The layout suggested by Moorehead and Mott-Smith has the tableau in eight fans of three.
This is more attractive but less practical than a single row of eight, since any number of cards 
may be built on each tableau and all must be seen to plan moves.



Calculation    (aka Broken Intervals)
· Brain drain: Medium Odds: 5 to 1

· Layout: four foundation piles in a row, upper left. Four waste piles beneath them; deck off to the 
right.

· To win: Play all cards in order to foundations to win.

· Foundations: When you start the foundations contain one card each: Ace, Deuce, Trey, Four. 
Build on each foundation, not in suit, but in multiples of the starting rank, like so:

      A 2 3 4 5 6 7 8 9 10 J Q K        (1st fndn)
      2 4 6 8 10 Q A 3 5 7 9 J K        (2nd fndn)
      3 6 9 Q 2 5 8 J A 4 7 10 K        (3rd fndn)
      4 8 Q 3 7 J 2 6 10 A 5 9 K        (4th fndn)

· Play: Play one card at a time off the deck to foundations or waste until the deck is empty.You 
may play to foundations from waste piles, but not between waste piles. In the game shown 
above the Four on the first waste could be played to the Deuce on the second foundation, then 
the Six on the deck could be played to either the second or third foundation. The Ace on the third
waste is currently unplayable.

· Deal: no redeals allowed.

· Hint: It is usually wise to reserve one waste pile for Kings, which logjam other piles.



Canfield (aka Fascination, Demon)
· Brain drain: Medium Odds: 5 to 1

· Layout: A pile of thirteen cards called the reserves at middle left. Four foundations    across the 
top, then four tableau piles directly under the foundations. The deck is lower right with a fan and 
waste above.

· To Win: Play all cards in order by rank and suit to foundations.

· Foundations: The first card of the first foundation is played from the deck to start the game. The 
other foundations must start with the same rank. Build upon the other foundations as each card 
of that rank becomes available. (In the game shown above the Four of Clubs on the reserve pile 
can be played to an empty foundation, then the Five of Diamonds and Clubs could be played on 
top of the Fours as they come into play.) Build each foundation pile up in circular rank and suit 
until each foundation pile has thirteen cards.

· Tableau: build down in alternating colours and circular rank. Play from the tableau is restricted: 
free cards may be played to foundations, but tableau piles can only be transferred as an entire 
block to another tableau. When a tableau pile becomes empty it is automatically filled from the 
reserves until the reserves pile is emptied. Thereafter, you may fill an empty tableau pile as you 
desire.

· Reserves: play to tableau and foundations whenever possible.

· Deal: three cards at a time are dealt to waste until the deck is empty. Redeal the deck as 
necessary.

· Note: this is, to the best of my knowledge, the historical version of Canfield.



Chameleon
· Brain drain: Medium Odds:4 to 1

· Layout: a pile of thirteen cards called the reserves at middle left. Four foundations traverse the 
top, then four tableau piles lay directly under the foundations. The deck is lower right with a fan 
and waste above.

· To Win: Play all cards in order by rank and suit to foundations.

· Foundations: The first card of the first foundation is played from the deck to start the game. The 
other foundations must start with the same rank. Build upon the other foundations once each 
card of that rank becomes available. Build each foundation pile up in circular rank and suit until 
each foundation pile has thirteen cards.

· Tableau: tableau piles, build down in circular rank regardless of suit. Four example play the King 
of Diamonds on the Ace of Hearts in the game shown above. This will automatically pull the Jack
of Diamonds from reserves to the now empty tableau pile. Move the Ten of Clubs upon the Jack 
of Diamonds, then the Nine of Spades from waste upon the Ten of Clubs.

Any free card on the reserve, the tableau, and waste may be played to the tableau. When a 
tableau pile becomes empty it is automatically filled from the reserve, until the reserve is 
emptied. Thereafter, you may fill an empty tableau pile as you desire. Groups of cards may be 
moved together between tableau piles.

· Reserves: play to tableau and foundations whenever possible.

· Deal: one card at a time until the deck is empty. No redeal is permitted.

· Hint: while Chameleon lets you build cards on the tableau without regard to suit, use the 
capability of moving partial piles to keep suits together as much as possible.

· Note: officially Chameleon only has three tableau piles, which makes it more frustrating than fun. 
With four tableau it resembles Canfield in looks but not in play - which I admit can be confusing.



Dutchess    (aka Glenwood)
· Brain drain: Medium Odds: 3 to 1

· Layout: four reserves fans of three cards each run from top to bottom left. Four foundations run 
across the top middle with four tableau piles directly under the foundations. The deck is lower 
right with waste above.

· To Win: Play all cards in order by rank and suit to foundations.

· Foundations: Move any available card from reserves to the first foundation to start the game. 
Start the other foundations as each of the other cards of the same rank becomes available. For 
example, in the game shown above the Ace of Diamonds on the reserves would be a good 
choice to start foundations. Then both Aces on the tableau could also be played to foundations, 
then the Deuce of Clubs from the reserves could be played upon the Ace of Clubs.

Build each foundation pile up in circular rank and suit until each foundation pile has thirteen 
cards.

· Tableau: build down in alternating colours and circular rank. For example, play the Jack of Clubs 
on either red Queen in the game above.

When a tableau pile becomes empty you must fill it from the reserves until the reserves are 
emptied. Thereafter, you may fill an empty tableau pile as you desire.

Play between tableau piles is restricted: tableau piles may only be transferred as an entire block 
to another tableau.

· Reserves: play to tableau and foundations whenever possible.

· Deal: one card at a time until the deck is empty. One redeal is allowed.



Eight Off
· Brain drain: Medium Odds: 2 to 1

· Layout: four foundations top centre, eight reserves below them in a row from left to right. Four of 
the eight reserves are dealt a single card each at the start of the game. Eight tableau piles in a 
row below the reserve. Each tableau pile starts with six cards. Finally, the deck is in the upper 
right corner and is empty at the start of the game from dealing the initial layout.

· To Win: Play all cards to foundations in order by rank and suit from Ace to King. 

· Reserves: Play cards one at a time to foundations or tableau. Any free card may be moved from 
the tableau to any empty reserve pile. but only one card may be stashed on a reserve pile at any 
given time.

Free reserve piles are your most valuable resource. They act as temporary docking stations to 
free up needed cards buried in the tableau.

· Tableau: build down by rank and suit. Move one card at a time from tableau to tableau or to any 
empty reserve or to foundations as rules permit. Empty tableau piles may only be filled with 
Kings.

For example, the game shown above has already been started. Moving the Jack of Spades on to
the Queen of Spades on the seventh tableau frees the Six of Spades for play to the Five of 
Spades on foundations. Once this is done the Seven of Spades - already free on the Tableau - 
can be moved to foundations, as can the Eight of Spades on the reserves. Now the Deuce of 
Hearts is free to send to foundations, as well. Things are rarely this easy!

· Hint: when building down on a tableau pile, be wary of trapping a lower card of the same suit. For
example in the game shown above, the last tableau pile has a build of the Six, Five, and Four of 
Hearts. Were the Deuce of Hearts in the same pile and above the run, it would be trapped unless
two or more vacant reserve piles were free.



Four Seasons    (aka Corner Card)
· Brain drain: Medium Odds: 4 to 1

· Layout: five tableau piles in a cross. Four foundations fill the intersections of the cross. Deck, 
middle right; waste above.

· To win: Play all cards in order by rank and suit to foundations.

· Foundations: The first card of the first foundation is played from the deck to start the game. The 
other foundations must start with the same rank. Build upon the other foundations as each card 
of that rank becomes available. For example, in the game shown above play the Six of 
Diamonds from Waste to any empty foundaion. Build each foundation pile up in rank and suit 
until each foundation pile has 13 cards by means of circular rank if necessary.

· Tableau: build down regardless of suit using circular rank if necessary. Move one card at a time 
from a tableau pile elsewhere. Fill an empty tableau pile as desired. In the game above build the 
Four of Clubs on the Five of Clubs and the Trey on the Four to free two tableau piles for play 
from waste. The two tens cannot initially be played to.

· Deal: one card at a time until the deck is empty. Once the deck is exhaused, no redeals are 
allowed.



Golf
· Brain drain: Low Odds:40 to 1

· Layout: Before play begins cards are dealt to the reserve in seven piles of five across the top. 
There is one foundation pile which also serves as waste at bottom center. The deck is bottom 
right. No tableau piles.

· To win: play all cards to the foundation pile to win.

· Reserves: send any free card from the reserves to foundation if it is one lower or higher in rank 
from the card currently showing on the foundation pile. You can go higher or lower by one rank 
for each card you play. For example, in the game shown above play the King of Hearts from 
reserves to the Queen of Hearts on the foundation pile. Then play the Queen of Diamonds from 
reserves to the King of Hearts on the foundation.

· Note: officially, you are not allowed to play a Queen to a King. I'll leave that up to you.



Idiot's Delight    (aka Aces Up, Firing Squad)
· Brain drain: Low Odds: 50 to 1

· Layout: Four tableau piles in a row on the left. A single foundation pile upper right. The Deck pile 
is below the foundation pile.

· To win: The game is won when nothing remains but a King on each tableau pile. 

· Tableau: Aces are low, Kings high. When two cards are of the same suit, drag the lower atop the 
higher to send it to the single foundation pile. In the game shown above the Eight of Spades may
be dragged upon the King of Spades, sending it to the foundation. The Ten and Ace are of 
different suits so are presently unplayable. The next move would be to click on the deck to deal 
another round to the tableau.

Before each deal, you may fill any blank tableau piles with cards taken from the top of any other 
tableau pile with more than one card on it.

· Deal: Click on the deck pile to deal a card to each of the four tableau piles. Once the deck is 
exhaused, no redeals are allowed. 

· Note: officially, Aces should be high and Kings low - hence the variant name, Aces Up. The 
French Revolution is over.



King's Clover
· Brain drain: High Odds:2 to 1

· Layout: sixteen tableau fans in rows of five, each with three cards. Four foundations on the 
bottom. The game starts with the four Aces dealt to foundations. If no Deuces are available on 
the fans, reshuffle - play cannot proceed, as you'll see from the rules below.

· To Win: build foundations up in rank and suit to Kings on all four foundations to win. 

· Tableau: move free cards from fan to fan in the tableau, building up or down by rank. You may 
build both up and down in the same fan, but each fan can contain no more than three cards. 
Only the King of Clubs may be moved to an empty pile. For example, in the game above the 
Deuce, Trey, and Four of Clubs can all be played to the foundation Ace of Clubs. The Deuce, 
Trey, and Four of Diamonds can be played to the Ace of Diamonds. Next, one might move the 
now available Five of Diamonds or the Five of Hearts upon the Six of Clubs to expose another 
Deuce for play to foundations.

· Note: this game is my own variation on the game Shamrocks.    In Shamrocks the foundations 
start empty - you move the Aces out as you expose them. This requires a tableau of eighteen 
fans, which is too crowded for VGA. Shamrocks also differs in that empty tableau fans may not 
be filled, but Kings may be moved under cards of the same suit in the same fan.



Klondike
· Brain drain: Medium Odds: 25 to 1

· Layout: Four foundations across the top centre. Seven tableau piles directly under the 
foundations: pile 1 has one card, pile 2 has two cards, and so on to pile 7. The deck is lower right
with a fan and waste above.

· To Win: Play all cards in order by rank and suit to foundations.

· Foundations: As each Ace appears play it to an empty foundation. On each foundation Ace play 
the Deuce, the Trey, etc up to King of the same suit as that Ace.

· Tableau: build down in alternating colours. For example, in the game shown above move the 
Four of Diamonds upon the Five of Spades and the Four of Clubs upon the Five of Hearts. 
Single cards or groups of consequetive cards may be moved from pile to pile as long as the 
cards in their new location continues building down in alternating colours. Empty piles may only 
be started with a King.

· Deal: three cards at a time are dealt to waste until the deck is empty. Redeal the deck as 
necessary.

· Note: this is the version of solitaire that comes with Windows.



Little Spider
· Brain drain: High Odds: 5 to 1

· Layout: eight tableau piles in a row with four foundations above them. Deck, upper right.

· To Win: Play all cards in order by rank and suit to foundations.

· Foundations: As they appear on the tableau, move up two Aces and two Kings - Aces red and 
Kings black or vice versa to foundations. Build up from Aces or down from Kings in the same 
suit.

· Tableau: there are two stages to Little Spider. In the first stage, click on the deck to deal one card
on each tableau pile, then pause to play any allowed cards to foundations before dealing another
round. In this stage no play between tableau piles is allowed. In the sample game shown above 
play is ready to begin. One might play the Ace and Deuce of Hearts and the King of Clubs up to 
foundations before dealing the next round.

Once the deck pile is emptied, the second stage begins. Continue play to foundations when 
possible. The top card of each tableau pile is available for play. Build up or down in order, 
regardless of suit. Kings may be played upon Aces and vice versa. Empty tableau piles may not 
be filled.

· Note: The layout suggested by Moorehead and Mott-Smith has the tableau in two rows of four 
with the foundations between. This is impractical on-screen, hence the single row of eight. 
Officially, during the deal phase only the starting Aces and Kings may be played freely from 
tableau piles four through eight. During the deal succeeding cards may be played from tableau 
four to foundation one, tableau five to foundation two, etc. You may want to follow this rule, but 
because of the change in layout, it hasn't been enforced.



Osmosis
· Brain drain: Low Odds: 2 to 1

            Osmosis is harder in the telling than the playing --

· Layout: Four reserves piles in a column on the left. Four foundations in column to the right of the 
reserves. Deck lower right; waste above it. 

· To win: play all cards to the foundation pile to win.

· Foundations: build foundation piles with cards of the same suit regardless of order. The first card 
of the first (top) foundation is played from the deck to start the game. Play to the lower 
foundations as each card of the same rank as the first card on the first foundation becomes    
available.

On the first foundation pile play any card of the same suit as it becomes available. On the other 
three foundations, you can only play a card of the appropriate suit if its match in rank can be 
found on the first foundation.

For example, the game shown above is ready to get off to a hot start. The Six of Spades from the
waste fan and the Four and Queen of Spades from reserves can be played upon first 
foundation's the Deuce of Spades. Hopefully, the Deuce of Hearts at the bottom of the waste fan 
will become available soon. When that happens the Queen of Hearts on waste will also be 
playable to foundations because the Queen of Spades is out.

· Reserves: there are no tableau piles. To the left of the foundations are four reserves piles. The 
top card of each reserves is available for play to the appropriate foundation when rules allow

· Deal: three cards at a time are dealt to waste until the deck is empty. Redeal the deck as 
necessary.



Penguin
· Brain drain: High Odds: 2 to 1

· Layout: four foundations top centre, seven reserves (called flippers) below them in a row from left
to right. Seven tableau piles in a row below the reserves. Each tableau pile starts with seven 
cards. The first card dealt to the tableau is called the penguin. The penguin's rank establishes 
the foundations. As each other card of that rank turns up in dealing the tableau, it is moved up 
before play begins to start one of the four foundations. (The penguin must be unburied to start 
the first foundation.)

· To Win: Play all cards to foundations in order by circular rank and suit. 

· Reserves: Any free card may be moved from the tableau to any empty reserve pile. but only one 
card may be stashed on any one reserve pile at any given time. Play cards one at a time from 
reserves to foundations or tableau.

Free reserve piles are your most valuable resource. They act as temporary docking stations to 
free up needed cards buried in the tableau.

· Tableau: build down by rank and suit. Move cards from tableau to tableau or to any empty 
reserve or to foundations as rules permit. Empty tableau piles may only be filled with cards one 
less in rank than the penguin. A block of cards in sequence may be moved from one pile to 
another.

In the game shown above the Jack of Hearts on the second tableau pile may be sent to 
foundations. The Three of Hearts on the seventh tableau could be played to reserves, freeing the
Jack of Clubs for play to foundations.

· Note: This fiendish game was invented by David Parlett and may be found in his superb 
collection of some 500 solitaires, The Penguin Book of Patience.



Perpetual Motion
· Brain drain: Low Odds: 1 to 1

· Layout: four tableau in a staggered row to the left. A single foundation upper right, and deck 
below it. 

· To win: play all cards to the foundation pile to win.

· Tableau: when two cards are of the same rank, drag the one to the right atop the the one to the 
left. When all four are the same rank, press F to clear them off to the single foundation pile.

In the sample game shown above the Six of Spades can be dragged upon the Six of Hearts to 
start the game. Clicking on the deck will deal another round of cards to the tableau to continue 
play.

· Deal: click on the deck pile to deal a card to each of the four tableau piles. When the deck is 
exhausted, all the tableau cards will be collected in order and returned to the deck pile.

· Note: officially, the deck is rebuilt by collecting the tableau piles from right to left, then playing 
from the bottom of the newly formed deck pile. The King's Solitaire plays from the top, making 
the game slightly more winnable. In fact, if anyone manages to lose at this game, I'd like to hear 
about it.



Pyramid
· Brain drain: Low Odds: 50 to 1

· Layout: twenty-eight reserve piles in a descending pyramid in the middle. One foundation pile 
upper left. The deck, lower right; and waste, upper right.

· To win: play all cards to the foundation pile to win.

· Reserves: Aces count as 1, Jacks 11, Queens 12, Kings 13, other cards their rank. Drag either of
two uncovered cards from reserves, deck, or waste which add up to 13 onto the other to send 
them both to the single foundation.    It's also a valid move if two reserve cards add up to 13 and 
one is covered only by the other. Unfortunately, you may not fill an empty reserve pile with a card
from another pile or move cards between reserves piles.

In the sample game shown above the Five of Spades on the reserves can be played upon the 
Eight of Hearts on the deck, packing them both off to the foundation pile. The Deuce of Clubs on 
the last reserves pile can be dragged upon either the Jack of Clubs on waste or the Jack of 
Hearts on reserves. The Deuce of Clubs cannot, however, be played against the Jack of 
Diamonds beneath it, since the Ace of Clubs still partially blocks the Jack of Diamonds.

· To Deal: When no moves remain, click on the deck to deal another card to waste. Once the deck 
is exhaused, no redeals are allowed.

· Note: Pyramid favours long runs. Very little in luck or skill is needed to rack up a run of a quarter 
deck or more. For this reason the first 18    cards of a run in Pyramid are handicapped from the 
run bonus.



Queen's Quadrille
· Brain drain: Medium Odds: 25 to 1

· Layout: eight foundation piles in a circle with three waste piles in its centre. A fourth waste 
(reserved for Queens) is upper right. the Deck is middle right.

· To Win: Play all cards to the foundation piles to win.

· Wastes: Each card dealt from the deck, which cannot be played directly to a foundation pile must
be sent to any waste pile. Try not to bury soon to be needed cards with cards which will not be 
needed for a while.

· Foundations: In Quadrille ignore suit; only card ranks are significant. As Fives or Sixes become 
available play them to any empty foundation pile. Build foundation piles starting with a Five down
in rank to Ace and on an Ace play a King. Build foundation piles starting with a Six up in rank to 
Queen. Any card you cannot immediately play to foundations must go to one of the central waste
piles, except Queens which go to the upper right pile (awaiting suitably ranking partners to join 
the dance).

In the example game above, the Seven of Spades on the first waste pile may be played to either 
foundation Six. The Five of Diamonds can be moved from the deck to any empty foundation, 
then the Four of Hearts played upon it.

· Deal: one card at a time until the deck is empty.    Once the deck is exhaused, no redeals are 
allowed.

· Note: This game is my own creation, taking the concept of a circle of fives and sixes from the 
game Captive Queens, also known as Quadrille - hence the name. Captive Queens offers little 
challenge, but Queen's Quadrille varies from breezy to just plain nasty.



Scorpion    (aka Snake)
· Brain drain: High Odds: 15 to 1

· Layout: before play begins all cards are dealt to the tableau in seven piles each with seven card 
across the top, which leaves a reserve of three cards on the deck pile, lower right. The first three 
cards in the first four tableau piles are face down; the rest face up. There are no foundation piles.

· To win: move all cards into any four tableau piles from King down to Ace in suit.

· Tableau: On the free card of each pile put the next lower card of the same suit - even if that card 
is not free. Any cards below it simply tag along for the ride.

For example don't strain your eyes but in the game shown above the third card in the sixth 
tableau pile is a Queen of Hearts. It may be dragged on to the King of Hearts at the bottom of the
first tableau. Doing so brings the Jack, Deuce, Six, and Four from the sixth tableau along with the
Queen of Hearts to rest on the first tableau. Once done, that Deuce of Hearts now on pile one 
can be dragged upon the Trey of Hearts on pile three.

Kings (with any covering cards) may be moved to an empty pile. No card may be played upon an
Ace.

Each face down card in the first four piles is turned face up when freed.

· Deal: when no other play remains, press the space bar or click on the deck pile. The remaining 
three cards will be turned up upon the first three tableau piles.

· Note: because there are no foundations in Scorpion both cards left and runs are calculated 
differently from other games. In Scorpion any tableau pile which starts with a face up King is 
considered to be a foundation pile. The number of cards in a descending run on such Kings are 
summed for scoring purposes. 

· Note: Scorpion is a fun game but occasionally yields very long piles (try this game with real cards
sometime to see why its often called Snake). King's Casino compresses piles which get longer 
than can be shown in the current window. Don't forget: you can always check on a buried card by
dragging the card covering it to one side, then letting it snap back. Scorpion is more comfortable 
when played in an SVGA video mode.



Strategy
· Brain drain: Medium Odds: 3 to 1

· Layout: Strategy has the usual four foundations in a row across the upper centre. However, it's 
seven playing piles in a row below the foundations are called waste piles not tableau, since you 
may not move cards from pile to pile among them. The Deck pile is to the right, as usual.

· To Win: Play all cards in order by rank and suit to foundations.

· Play: there are two stages to Strategy. In the first stage, deal from the deck one card at a time. 
Play Aces as they appear to foundations. Play all other cards to the waste piles. You may put any
card on any other card regardless of rank or suit as you build the wastes.

For example, see the sample game shown above. The Eight of Diamonds is next on the deck. It 
might best be played upon the Nine of Clubs on the first waste pile, rather than starting a new 
pile of its own (see Hint below).

Once the deck pile is emptied, the second stage begins. The top card of each waste pile is 
available for play to foundations. Build the foundations up from Ace to King in order by rank and 
suit. Auto Finish does the job nicely. 

· Hint: since you can't rearrange the cards on the waste piles, the trick is to put the cards down on 
waste in reverse order. Morehead and Mott-Smith suggests you build generally downward 
regardless of suit, and that you reserve a pile for Kings, another for Queens, and possibly a third 
for Jacks. Only start a pile with a card lower than Ten when forced to. Obviously, never put a 
higher card on a pile with a lower card of the same suit, but even so cards may interlock between
waste piles to create impasses.

· Note: officially, this game should have eight waste piles. For once, I had to ax the pile count to 
help the game live up to its name.

· Note: won games by necessity entail a run of 48 cards to the foundations, and lost games 
normally allow at least half the deck to play as a run. For this reason the first 36 cards of a run in 
Strategy are handicapped from the run bonus.



Tournament
· Brain drain: High Odds: 4 to 1

· Deck size: two decks (104 cards).

· Layout: four reserves (traditionally called kibitzers) in a column on the left and four on the right. 
Between the kibitzers are six waste piles (traditionally called dormitzers) in a row. Above the 
wastes are two rows of four foundations. The upper row for Aces; the lower for Kings. The deck 
is beside the Kings row.

· To win: play all cards in rank and suit to foundation.

· Foundations: as an Ace of each suit appears play it to an upper foundation pile. Build up in rank 
and suit on Aces. In the game shown above both the Ace of Diamonds and the Ace of Spades 
may be played to foundations to start the game. As a King of each suit appears play it to a lower 
foundation pile. In the game above the King of Clubs on the tableau may be played to any lower 
foundation pile. Build down in rank and suit on foundation Kings. It helps to place the Ace and 
King of each suit in line. 

Tournament is the only solitaire in this suite which allows play between foundations. When the 
Ace and King pile of the same suit meet in rank (for example, the Ace pile is built up to Six and 
the King's pile down to Seven), you may play cards between the two piles.

· Reserves: each reserve pile is dealt one card to start the game and may hold only one card at a 
time. Unlike most other solitaires, you may fill empty reserve piles if desired from wastes. Play 
reserve cards to foundations as rules allow.

· Wastes: each waste pile is dealt four cards to start the game and is dealt four more whenever it 
is emptied. No play between wastes is allowed. Play available cards from waste piles to 
foundations or reserves. 

In the game above the King of Clubs can be played to foundations as mentioned, and the Deuce 
of Diamonds can be played to foundations once the Ace of Diamonds on reserves has been 
played. Because these are waste piles, no cross-pile moves such as playing the Four of Hearts 
on the Five of Hearts is permitted. Either move the Deuce of Hearts to an empty reserve or click 
on the deck to deal.

· Deal: click on the deck when no further moves are desirable, to deal four more cards to each 
waste pile. When the deck is empty the waste pile cards are collected to reform the deck. Two 



such redeals are allowed.

· Hints: it's crucial to keep at least one reserve pile empty except to make a play which will 
immediately open another reserve pile. For this reason, if no Ace or King appears in reserves to 
start the game, there's little hope - start a new game. 

· Note: Because Tournament is a two deck game it requires significantly more RAM than the one 
deck games. You may want to avoid starting this game in low RAM situations.

· Note: Tournament with 23 piles barely fits into a VGA screen. Waste piles can accumulate large 
numbers of cards. If you play Tournament in VGA mode, maximize the King's Casino window 
and even hide the status bar to prevent repeated pile compression and screen redraws. 
Tournament is more comfortable in an SVGA video mode.



Try Again (aka Old Patience)
· Brain drain: High Odds: 50 to 1

· Layout: four foundations form a central square, each awaiting an Ace. Four waste piles surround 
the foundations. The deck is middle right.

· To win: Play all cards to foundations in rank without regard to suit from Ace up to King to win.

· Play: deal four cards one at a time from the deck to any of the four waste piles. Play from the top 
of any waste to foundations when possible, then deal four more. There is no redeal and no play 
between wastes.

The first four moves of the sample game shown above have been played, bringing the deal 
counter to 4. Exceedingly good luck has actually turned up an Ace and a Deuce, so these cards 
should be played to any foundation pile before proceeding to the next round of deals. (Turning up
an early King so it can be played to the bottom of a waste pile is also highly fortunate. It doesn't 
matter - the game is sure to turn ugly very soon!)

· Hint: distribute cards of the same rank roughly one to a pile, so the top cards of each pile unravel
in ascending rank. At least one pile must start with a King or cards will be permanently buried.



Double or Naught
If you have won the current game, congratulations! Click on OK and add your winnings to your score.
Alternatively, click the button labelled Double in the Winner's dialog box to play Double Or Naught. If 
you play, you stand to multiply the amount you won for that game...or loose it all, depending on the 
outcome of your match.

If you choose to play, the deck is shuffled then the top six cards are dealt to the reserves in a pattern 
of three cards, two cards, one. The bottom card belongs to the house and is face up. The other five 
are face down. Click on whichever face down card you guess to be higher than the house's card; that
card is turned face up. If your card is higher, you are credited with doubled winnings and are offered 
the chance to double that amount. If your card is lower you loose your winnings and are returned to 
normal play. If you tie, your winnings are untouched and you are offered the chance to try again.

Note that (as always) Kings, not Aces, are high. If the house turns up a King, the best you can do is 
tie. If the house turns up an Ace, the worst you can do is tie.

In the game shown above the player chose the fifth reserve pile, turning up a Six which lost to the 
house's Ten.

Hint: Double Or Naught is a sucker trap. If you do play, be leary of accepting the offer to double 
again, should you win a round. While the odds for any one round are 50/50, you double the odds 
against you each time you accept another round.



File and Game Menu Choices
The choices on the File and Game menus are primarily aimed at selecting which game you want to 
play next.

 Choosing a new game
 Restarting same game
 Saving and loading game files



Choosing a Game
The obvious way to start a new game is to click on its name under the Games menu. However, if you
simply want to start a new game of the same name as the one you last played, just press F2 or click 
on New Game on the File menu. If you want to play the next game on the Games menu list, press F3
or choose Next Game from the File menu. (If you were playing Idiot's and press F3, you will start 
King's Clover.)
        
For your added convenience, at any time during game play you can pop up the Games menu by 
clicking your right mouse button anywhere in the main window playing surface not covered by a card 
or pile marker.



Restarting a Game
To restart the current game from the beginning choose Restart from the File Menu or press Shift+F2. 

However if you only want to change the last few moves it's easier to choose Undo from the Actions 
menu or press Alt+Backspace the appropriate number of times.



Saving and Loading Games
· The File menu option Save Game allows you to record the current game to disk for future replay. 

You may want to use this feature to save an interrupted game for future continuation or to 
preserve a won game for gloating, sharing with a friend, or future use. Choosing Save Game 
opens the file common dialog. Type in a unique name then click OK. You may want to stick with 
the default .sav file name extension to make it obvious which files are saved games when you go
to reload one. If you make much use of this feature, you may also want to create a sub-directory 
in which to store saved games.

If you want others to play the game you are saving from the beginning, choose Restart from the 
File menu first, then save the game.

· To open a previously saved game, Choose Load Game which also starts the file common dialog. 
Double click on the name of the file you wish to reload.



Actions Menu Choices
The Actions Menu contains choices for actions you need to perform in the course of game play. 

The most common action is simply dragging cards from one pile to another, no menu choice is 
needed for this. 

The next most common action is to deal cards from the deck. The other three menu choices are 
used much less frequently.

 Deal
 Undo
 Peek
 Auto Finish



Deal Menu Choice
(Hot key: Space bar)

When all action has come to a standstill with the available face up cards, one usually needs to deal 
one or more cards (depending on the rules of the game) from the deck. This action is performed so 
frequently that you can simply press the space bar to invoke it. 

Depending on the game, when you invoke Deal one or more cards are played for you either to the 
waste pile or piles, an intermediate fan of three cards, or upon any existing cards already on the 
tableau piles (if any).



Undo Menu Choice
(Hot key: Alt+Backspace)

In a real casino taking back a move would definitely not be allowed. Since King's Casino is all in fun, 
you can take back as many moves as you like at any time by clicking on this menu option or pressing
the Alt+Backspace key combination.

If you wish to get back to the beginning of a game, it is usually easier to choose Restart from the File 
menu.

One limitation of the unlimited undo feature is that your deck redeal counts are not recalculated when
you undo a deal. This only applies to Dutchess and Tournament, which allow a limited number of 
deck redeals. (This limitation exists because I cannot figure out how to code the distinction between 
an undo for the sake of undoing a chain of moves and an undo for the sake of bypassing the redeal 
count in those two games.)



Peek Menu Choice

(Hot key: F5)

Another real casino no-no would be peeking into a pile of cards to locate a card you'd like to have 
available. In King's Casino we not only allow peeking, we provide a very convenient dialog box to 
help out. 

In the Locate Card dialog box click on a suit and a rank. The card pile and the position of the card 
you identified in that pile (from bottom as 1 to top) are indicated.



Auto Finish Menu Choice
(Hot key: F6)

In some games there comes a point when a win is inevitable. All that remains to do is to send the 
remaining cards on the tableau to the appropriate foundation piles, one by one. In this case you can 
let King's Casino do this for you by choosing Auto Finish. Note: Auto Finish can only be used once 
per game. Also note that Auto Finish is not a problem solver. It simply goes through all available 
cards and plays any to foundations that the rules allow. it does this until the game is won or until it 
can no longer find a valid move.



Using the Options Menu
The Options Menu has three choices. The first two, Visuals and Behaviours, are dialog boxes which 
allow you to customize how King's Casino Solitaire looks and acts. The third, Statistics, brings up a 
report on your scoring and earnings in each game.

 Visuals dialog box
 Behaviours dialog box
 Statistics table



Visuals Dialog Box

(Hot key: F7)

The Visuals menu choice pops up a dialog box for customizing many aspects of the appearance of 
King's Casino Solitaire. Whatever changes you make will take effect the next time you start a new 
game. Also, they will be recorded to the file KCSol.ini when you next exit the program and recalled 
whenever you start it again.

Background
This area contains options for changing the background of the main window. 

· Pictures 1 through 12. You can choose from up to twelve pictures (KB*.bmp files), or you can 
have a different picture selected randomly each new game. You can add your own artwork for 
King's Casino to display. Note that the number of picture buttons you have available indicates the
number of KB*.bmp files the program finds in its home directory up to a maximum of twelve. Also
note: using pictures as backgrounds can dramatically increase the already hefty amount of RAM 
King's Casino uses.

· Random picture each game. If you have more than one picture file in your King's Casino Solitaire
directory, this option will randomly select one to display at the start of each new game.

· Solid colour background. If you click on this option, then the next time you start a game the 
background will be set to the currently selected solid colour with one of the four kings in the 
upper left corner. This option may not be exciting but it can drastically reduce the amount of RAM
King's Casino uses! If your hard disk light flashes incessantly and irritating pauses interrupt your 
play, turn this option on.

· Colour. This button allows you to select a solid background for the main window. If you have 
selected Solid Colour from the background radio button choices, then the next time you start a 
new game the background will be the colour you chose in this window. Alternatively, if you have 
selected a picture background that does not fill the entire main window, any left over areas will be
filled with this colour.

Card Decks
This half of the Visuals pop up window allows you to choose which deck style (card back design) you
wish to use. Remember the change will not take effect until you start a new game.

· Deck 1 through 6. Click on any of these radio buttons to select which single card back design will
be used in future games.

· Change deck each game. If you click on this, King's Casino Solitaire will cycle through all six 



decks, choosing the next one on the list each time you start a new game.



Behaviours Dialog Box

(Hot key: F8)

This menu choice pops up a dialog box of check boxes, each of which controls one of the following 
aspects of the way this program interacts with you during game play:

· Single-clicking: whether a single click or a double-click on a card causes the program to move it 
to the first valid pile it finds a move for. Enabling single-clicking makes for fast and lazy play but 
does not always do what you expect. If you are new to computer solitaire you may want to leave 
this off until you feel comfortable with normal, drag-and-drop-style play.

· Fast computer moves: whether card moves initiated by the program itself look like user drags or 
simply flash the card(s) to the new location (fast automatic moves). If you have a fast computer, 
unselecting this choice will show off its speed.

· Show bottom: whether the bottom line status bar appears. If you are a frequenter at the Eight 
Off, Scorpion, or Tournament tables in VGA mode, you may want to hide the status bar to 
recover that little bit of extra playing surface.

· Confirm abandon: whether King's Casino prompts for confirmation before abandoning an 
unfinished game to start a new game. If selected the program will look for available moves with 
the cards as they liey on the table, only prompting for confirmation if it finds any. (However, it is 
not terribly bright and will not recognize when remaining moves lead nowhere.)

· See-through card pile markers. King's Casino now has two pile marker styles. One style is the 
traditional card-shaped rectangular solid. The default is a style with various different shapes to 
indicate the different pile types. This is useful when learning to play a new game. The new style 
also uses outlining instead of solid area fills to permit more of the background image to be seen 
through empty pile locations.

· Number of: how many times King's Casino shuffles the deck before starting a new game. You 
may enter a number from 1 to 9. The deck always starts fresh; during a shuffle, each card is 
swapped with another card chosen at random.



Statistics Table

(Hot key: F9)

King's Casino keeps track of a few stats for you, which you can see in the Statistics Table by 
pressing F9 or right-clicking on the status bar at any time.

· Starts. The Starts number for each grows by one for each game you play for more than ten 
moves or in which you move more than one card to foundations. The number at the bottom of 
the column is the total of all starts for all games.

· Wins. The Wins number for each game grows by one each time you play a game to a win. The 
number at the bottom of the column is the total of all wins for all games.

· Odds. The Odds column shows the odds against winning for each game and accordingly the win 
bonus for each game. These odds are initially set to the win/loss ratios achieved by previous 
players, but are recalculated to match your own starts/win ratio as you play more than ten of any 
game. The number at the bottom of the column is the average of all game odds.

· Wins Pay. This column shows how much each game pays for a win. This number is $20 times 
the odds current against winning for each game. The number at the bottom of the column is the 
average of all game odds.

· Winnings. The column labeled Winnings records how much you've won/lost for each game. 
Losses are shown in red. This number subtracts the $52 you pay to start a game ($104 for 
Tournament), adds the $1 you get back for each card played to foundations, adds the money you
earn for the longest run of that game, adds the amount in Wins Pay if you win, and finally adds or
subtracts your Double or Naught win/loss amount if play it after a win. The number at the bottom 
of the column is the total of all your winnings.

· Avg. Left. This column reports the average of the number of cards away from a win you've 
achieved for each game. While winning is as much a function of luck as skill in most Solitaires, 
the better you play the lower you can keep your average. Of course, an average of twelve cards 
left may be excellent for Chameleon but mediocre for Baroness. The number at the bottom of the
column is the average of all cards left for all games.

· Longest Run. To further reward skill over luck King's Casino Solitaire also tracks your longest run
in each game. Again, some games defy long runs, while others make them easy. The number at 
the bottom of the column is the average of all the numbers in this column.



Scoring and Gambling

Scoring
The most fundamental score in King's Casino is the number of games you won versus the number of
starts for each different game. For many of you winning's the thing and these two numbers as shown 
on the bottom line status bar are all you'll be interested in seeing. 

But even without gambling King's Casino gives you a couple other key stats to measure your skill 
and luck by. Both the longest run you've achieved in the current game and the number of cards still 
unplayed to foundations are shown at the right on the bottom line status bar.

The Statistics table available from the Options menu or by pressing F9 or by right clicking on the 
status bar allows you to view your scores and stats for all games at once.

Gambling
King's Casino Solitaire employs an idea similar to Canfield's casino described under Solitaire History.
You buy the deck for $52 (two deck games like Tournament cost $104), winning back only $1 for 
each card to foundations. But, if you win you receive $20 times the odds against winning as posted in
the Statistics table. You can choose to keep these winnings or gamble on the chance of multiplying 
them by playing Double or Naught.

King's Casino also pays a bonus for runs. You are paid $1 for the first 13 cards in a run, $2 for the 
next 13, $5 for the next 13, and $10 for the final 13.

Playing for bucks adds a bit of spice to life according to the millions that flock to Las Vegas each 
year. If you want to add real flair to your play, consider yourself honour-bound to send me a check for
the amount of any negative balance to your account at the end of every month! - Of course, I 
unfortunately will not be able to reciprocate at this time...



Registration and Upgrade Info
King's Casino comes in two flavours, a publically available evaluator edition and the fully-enabled, 
privately distributed, registered user's edition.

The evaluator edition of King's Casino Solitaire only allows 25 moves in all but the first three games. 
Should you ever tire of playing only the first three games you may want to click on the button below 
to find out how to acquire the inexpensive, fully-enabled version.

If you have already purchased the registered edition of King's Casino, congratulatons! Please accept 
my sincere thanks for your support.

 Receiving your fully enabled copy
 Upgrades

You may reach me at the following mail and e-mail addresses for at least the following two years (through
1996):

Mail:
Dale Cotton
1520 Alpine Lane
Pickering    ON    L1X 2G3
Canada

E-Mail:
Compuserve: 73632,703
Internet: 73632.703@Compuserve.Com



Receiving your Fully Enabled Copy
King's Casino Solitaire Evaluator edition only lets you make 25 moves in all but three games. It is an 
evaluation copy of the privately available, fully-enabled version. You may use the evaluation copy 
without charge for as long as you wish.

I invite you to use and explore the evaluator edition. I know the 25 move limitation is frustrating. In an
ideal world everyone would register as soon as s/he determined that s/he liked the program. But I 
find it easy to put off registering and I know others do too.

I believe you will have a great deal of fun with the three uncrippled games and will want to have full 
access to them all. If you find you agree with me, take a minute to sit down and write me a personal 
cheque for the modest sum of $16.50. Then stick it in an envelope and address it to me. If you like, 
you can pop up the file KCOrder.txt in Notepad, fill it in and print it. Otherwise don't forget to include a
return name and address and mention that you are registering King's Casino Solitaire. I will put a 
disk containing the fully functional version in the mail within a day or two of receiving your order.

Compuserve users can register by typing GO SWREG at any ! prompt. The registration I.D. is 3173. 
If you register via SWREG or otherwise let me know your e-mail address I can expedite your receipt 
of the fully enabled version.

Thank you for taking the time to evaluate this program.



Upgrades
When I receive your registration request I will send you the latest version (unless you request 
otherwise), regardless of how old a version you are registering from.

Once registered you are entitled to electronically distributed upgrades for free or snail-mail upgrades 
on diskette for the cost of mailing/handling (currently $2.50). Contact me via mail or e-mail if you wish
to upgrade.



Adding to the Artwork
King's Casino now supports multiple background and winner's pictures. Six background and six 
winner images are supplied with this version. This constitutes what I call an image set. Each time a 
new background image is needed, the program makes a list of the first twelve files starting with KB 
and ending with .bmp (KB*.bmp) it finds in its home directory. Similarly, when a winner's picture is 
needed it looks for KW*.bmp files (no limit on how many) and chooses one at random. Thus, the 
images used by King's Casino are entirely up to you. If you don't favour any of the supplied bitmaps, 
delete them. If you have any .bmp files you would like to use, add them to the home directory, as 
well. 

· Copy any .bmp file of the desired dimensions to the King's Casino home directory.

· Rename the new .bmp to KBxxxxxx.bmp or KWxxxxxx.bmp, where the xs can be any characters 
valid in a DOS file name. There don't have to be six new characters - that's the maximum. 
Following the KB, I use a character to indicate which screen size the background image will fill. I 
use KB6 to indicate 640 by 480, KB8 for 800 by 600, and KB1 for 1024 by 768.

Winner Bitmap Dimensions
Ideally, your winner's images should be 320 by 320 pixels in size, but the program will compress or 
expand any KW*.bmp file it finds to fit those dimensions. 

Background Bitmap Dimensions
Background bitmaps are handled a bit differently. For technical reasons the program does not 
compress or expand background images to fit the window. Two sets of background pictures are 
provided: one set for VGA and another for 800 by 600 SVGA.    The VGA images are 640 by 442 
which just fills the main window if maximized in standard VGA. (Two more pictures, KB1Celt.bmp 
and KB1Celt2.bmp add a stripe of decor across the top of the main window. They work equally well 
in all three resolutions and take up little space.)

If you use Windows in 800 by 600 or higher resolution and size King's Casino's main window to 
something bigger than 640 by 442, the VGA bitmaps will not fill the whole window. Nor will they be 
centered in the window. Instead the upper left corner of the picture will always originate in the upper 
left corner of the window. If this does not jive with your esthetic sensibilities, you need to use the 
SVGA bitmaps supplied or others of your choice. 

If you have bitmap images of the wrong size, AllPaper, a PC Magazine utility by Jeff Prosise, will 
resize them for you simply, elegantly, and best of all for free. You should be able find this program on 
most any BBS. You might also want to use the outstanding Graphics Workshop for Windows from 
Alchemy Mindworks, a shareware program which allows you to resize, convert, transforms, crop, and
much more, files most any graphics format.

 Creating Your Own Image Sets
 Testing Image Sets



Creating Your Own Image Sets
If you are artistically inclined (or even if you're not!), feel free to create your own images in 
Paintbrush or other bitmap editor.

To create a winner's bitmap in Paintbrush
· Choose Image Attributes from the Options menu.
· Set both Width and Height to 320 pels. Click on the OK button.
· Select File / Save, assign the file a name, then still in File / Save
· From the Save File as Type list box select 16 Color bitmap (*.bmp).

To create a background bitmap in Paintbrush
While winner pics are always the same size, the size of a background image depends on which 
Windows display driver you are using and how much of the main window you wish to fill. You can 
press the S key in King's Casino at any time to find out the current window size in pixels (pels). I 
recommend using the size of the maximized King's Casino window in VGA mode (640 by 442) and 
scaling the results for other resolutions.

· Choose Image Attributes from the Options menu.
· Set Width to 640 pels and Height to 442 pels. Click on the OK button.
· Select File / Save, assign the file a name, then still in File / Save,
· From the Save File as Type list box select 16 Color bitmap (*.bmp).

Colour Considerations
Note that Paintbrush will default to creating 16 colour or 256 colour images depending on which 
resolution you are running Windows in. Users with 16 colour displays will be able to use 256 colour 
images, but the colours may not always be what you expected and the file sizes will be much larger.

You may occasionally experience colour problems with photographic images or drawn pictures with 
custom palettes. Theoretically Windows knows how to handle the mix of 256 colours in a background
and 16 colours in the playing cards. In practice, on some displays I have seen the background 
showing unsightly colour blotches when a card is removed from a given location. This problem tends 
to disappear after repeated use of the same image(s).

 Testing your new images

Sharing Your Work
If you are proud of your work, please post .zip archives of your images to CompuServe's WINFUN 
forum or other BBS for others to share. Mention in the description blurb that your file contains one or 
more King's Casino Solitaire image sets. There's a brisk trade in Mahjongg tile sets; no reason why 
the same synergy shouldn't occur for King's Casino. I may dicker with the artist for inclusion of image
sets I would like to package with future releases of King's Casino.



Testing Image Sets
Once you've created one or more of your own images you'd like to use in King's Casino, follow the 
steps below to give them a try.

Testing winner's bitmaps
· Rename each bitmap file if necessary so its first two letters are KW.
· Move each bitmap to the King's Casino home directory.
· Move other KW*.bmp files out of the King's Casino directory if you only want to view your new 

pictures.
· Start King's Casino Solitaire and start any game.
· Press the exclamation key (!) then make any valid more in that game.

The exclamation key forces a win and pops up the winner's dialog display. Press it again to return to 
normal play.

Testing background bitmaps
· Rename each bitmap file if necessary so its first two letters are KB.
· Move each bitmap to the King's Casino home directory.
· Move other KB*.bmp files out of the King's Casino directory if you only want to view your new 

pictures.
· Start King's Casino Solitaire.
· Start the Visuals dialog from the Options menu.
· Click on any un-greyed Picture buttons, click on OK.
· Start a new game.
You can view the current background uncluttered by cards and pile markers at any time by pressing 
the W key. To restore the card layout press W again.



Program Notes and Credits
Notes
The games in this suite of solitaires have mostly been chosen by the author from The Complete 
Book of Solitaire and Patience Games by Albert H. Morehead and Geoffrey Mott-Smith. While I used 
this sage tome as a guide I have not adhered to it fanatically. All exceptions are noted in the help 
screens for the individual games. King's Casino uses the wonderful QCard playing card set drawn by
Daniel DiBacco and programmed as a Windows dynamic link library by Stephen Murphy. This is 
brush and bit-blt magic of the highest order. (Daniel can only be held responsible for card faces and 
the two non-medieval card backs.

I intend King's Casino Solitaire to be an on-going project, to house a goodly measure of solitaires 
under one roof. I shall also be glad to add your favourite game, if I can figure out how to code it: 
Certain games follow rules which may come naturally to a human but which are designed to drive a 
programmer to bungee jumping. For example, consider this line from Morehead / Mott-Smith 
describing the game Moojub: "The number of foundation cards [piles] depends upon chance..." Also, 
there are certain non-traditional solitaires I consider to be the property of other programmers and 
would not feel right about copying.

Because of the relatively large size of an on-screen card relative to the relatively small size of a 
standard VGA screen, I have only included games which can fit into a layout four cards high by eight 
cards wide in this release. A future release may address this restriction either by using a smaller deck
or by requiring a higher resolution display for games which need more screen space.

I will endeavour to respond to any comments, criticisms, requests for new functionality, and requests 
for additional solitaires. Anyone who first suggests a new feature or new game which I subsequently 
incorporate or first finds a bug which I subsequently squash, will certainly receive the full version for 
free or have his payment returned if already registered.

In any case, send your comments and game requests. Let me know whether all the fun I had in 
writing this thing was in vain!

Credits
Special thanks to Sharon Ryan, John Cain, Ze'ev Ionis, and Michael Wake for beta testing and 
providing many valuable suggestions. Thanks especially    to Stephen Murphy not only for QCards 
but for surviving three months of begging, pleading, nagging, and cajoling. Also thanks to Graham 
Newton and Cedric Silvester for compiling many of the quips and quotes used in the Regrets and 
Platitudes dialog. Medieval beasts and patterns used in the graphics for this program come from 
Designs and Patterns from Historic Ornament by W. and G. Audsley and a Treasury of Fantastic and 
Mythological Creatures by Richard Huber, both Dover Pictorial Archive Series titles.

I recently chanced upon the Penguin Book of Patience by David Parlett and have added his original 
creation, Penguin, to the suite. I expect this book to have a much stronger influence on King's Casino
in future releases.



Glossary of Terms
All those little pop-up info boxes collected in one place.

A
alternating colours
available card

B
block
build order
build rules

C
circular rank

D
deal
deck

F
foundations

H
home directory

I
image set

L
layout

P
pile markers
pile

R
redeal
reserves
run

S
status bar

T
tableau

W
waste



License Agreement
(A) King's Casino Solitaire is Copyright 1994 by Dale Cotton. All rights are reserved. You may keep 
your copy of the registered version of this program on more than one computer, so long as only one 
person at a time is using it. Please pass on the evaluation version to your friends.

(B) King's Casino Solitaire has been tested within the capabilities of the author and seems to be 
problem-free. However, please note the following disclaimer of warranty:

THIS SOFTWARE IS SOLD 'AS IS' AND WITHOUT WARRANTY AS TO PERFORMANCE OF 
MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.    
BECAUSE OF THE VARIOUS HARDWARE AND SOFTWARE ENVIRONMENTS INTO WHICH 
THIS PROGRAM MAY BE PUT, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS 
OFFERED.    THE USER MUST ASSUME THE ENTIRE RISK OF USING THE PROGRAM.    ANY 
LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR 
REFUND OF PURCHASE PRICE. 

(C) You may not resell, charge for use, or charge for the distribution the registered version of King's 
Casino Solitaire without permission. Resellers and distributors must arrange for terms with me.

Subject to the above restrictions - enjoy!



Title



Pile Info Dialog Box

Right-click on any card or card pile at any time to pop up Pile Info. Shown above is Pile Info popped 
up over a game of Dutchess. By right-clicking on the various piles of a game you can learn how to 
play it or refresh your memory about a game you haven't played in a while. Note that this dialog box 
is modeless: once you pop it up you can click on various piles and it will report on each one until you 
click on OK.

· Pile: tells you whether the chosen pile is tableau, foundations, reserves, waste, waste fan, or 
deck.

· Fill Empty: tells you which card is at the bottom of an already started pile or which card is needed
to start an empty pile.

· Build by: what build rules (if any) apply to adding cards to this pile. Piles can be built in rank, in 
suit, in rank and suit, in circular rank, in alternating colours, or simply by adding the next 
available card.

· Build Order: once you know what rank and suit rules apply you also need to know whether you 
must build up or down (ascending or descending) in rank. Some piles allow you to build either up
or down with each new card added.

· Move: this tells you how many cards you can move FROM this pile at a time: none, a single card,
the entire pile, or any portion of the pile up to and including the entire pile.

· Move to: once you know what you can move, Move to tells you where you can it to.

· Notes: this field is a catch-all for any vagaries of the current game which apply to the current pile.

· Cues: this button turns pile cues on and off. A letter representing the pile type of each pile is 
displayed beside each pile. (D for deck; F for foundations; R for reserves; T for Tableau; W for 
waste.)



Actions menu
<Actions Menu>



add your own artwork
<Adding to the Artwork>



address it to me
<Registration and Upgrade Info>



alternating colours
In some games the build rules for the tableau require that a red card (either Diamond or Heart) be 
played on a black card (either Club or Spade) or vice versa.



available card
Any card not partially or wholly covered by one or more other cards. An uncovered card is available for 
play to other piles, depending on the rules of the game.



block
A group of two or more cards lying together on a pile.



build order
Whether you put a card of the next higher rank or the next lower rank on a given card. Some piles allow 
alternating higher and lower build order; some have no build order restrictions.



build rules
The restrictions on which card or block of cards may be added to the top of a given pile.



circular rank
Normally Ace is the lowest rank, Deuce next, on up to King. A pile with ascending circular rank often 
starts somewhere else than Ace - say Five - and moves on up to King as usual, but then the Ace is 
played upon the King, the Deuce on the Ace, and on up to Four so that the pile ends up with thirteen 
cards. It's like a clock with 13 hours. When you get to King o'clock (13),    Ace o'clock (1) comes next. 
Descending circular rank is the same principle. When you get down to an Ace, play a King and continue 
on down.



deal
When many games are started a certain number of cards are initially dealt to foundation, reserve, 
tableau, or waste piles. Once started, if any unplayed cards remain, the player may click on the deck to 
deal further cards, as rules permit, to waste or tableau piles.



deck
Or stock. This is a pile you move cards FROM. At the start of a new game the deck is shuffled then any 
cards needed for the initial layout are dealt. Thereafter the player clicks on the deck to deal more cards 
for play.



Double or Naught
<Double or Naught>



File menu
<File and Game Menus>



foundations
These are piles you ultimately want to move the cards TO in order to win. Some games have four 
foundation piles in a row across the top of the screen. Others have a single foundation pile, usually 
upper right.



Games menu
<File and Game Menus>



home directory
This is not a solitaire term. It refers to the sub-directory of your hard disk in which the King's Casino 
Solitaire executable, KCSol.exe, and its support files are stored.



image set
A collection of picture (bitmap) files displayed by King's Casino Solitaire with a common visual theme. 
Pictures files starting with KCB are used as backgrounds. Pictures starting with KCW are displayed 
when you win a game.



layout
A game's layout is the distinctive pattern of card piles on the screen (table).



Options menu
<Options Menu>



Pile Info dialog box
<Pile Info Dialog Box>



pile markers
Grey rectangles the same shape as a playing card. These are used on the playing surface to indicate 
where a card piles may begin. An X on a pile marker signifies that cards may not be played to that pile. 
An O indicates cards may be played. Cards may be played both to and from piles without an X or an O.



pile
One or more cards grouped together and separate from other cards in a game's layout. Cards in a pile 
may be squared so that the top card completely covers any cards underneath it, or spread either 
horizontally or vertically so that a portion of each card is showing. A horizontally spread pile is often 
called a fan.



redeal
Some games permit, when all the cards in the deck have been dealt, that unplayed cards be gathered 
back together as the deck so that further play can continue.



reserves
These are one or more piles you move cards FROM but (usually) not to. Reserve piles are on the left 
and act as sort of a second deck from which cards may be played to foundations or tableau piles.



Restart menu choice
<Restarting a Game>



Rules and Instructions for each Game
<Game Rules>



run
A run is an unbroken sequence of cards played from any other piles to foundations.



Solitaire History
<History>



Statistics table
<Statistics Table>



status bar
The optional stripe along the bottom of main window which shows the name, starts, wins, longest run, 
and number of cards not played to foundations for the current game. Your total account balance at 
King's Casino appears in the middle of the bar.



tableau
(Pronounced tab-low.) In the course of playing the game these are the intermediate working piles you 
have to move cards BOTH TO and FROM in order to continue play. These piles are located in the centre
of the screen or to the left. Cards may be moved from tableau pile to tableau pile (according to the rules 
of the current game), as well as to foundations.



Undo menu choice
<Undo Menu Choice>



waste
Waste or discard are piles you move cards both FROM an TO. Many games have only one Waste pile, 
above the deck, which acts as a temporary staging area for cards turned over from the deck which 
cannot be played elsewhere. Some games have multiple waste piles but no tableau piles. Cards may 
not be moved from waste pile to waste pile, but only to foundations or tableau.






